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License Agreement

Microsoft, Windows, Windows 95, Windows 98, Windows NT, Me are registered trademark of
Microsoft Corporation.  Pentium is a registered trademark of Intel Corporation. The TWAIN driver
and the AVI Creator is developed by VLSI Vision Ltd.,UK. The Photo Fantasy, Photo Printer and
Photo Studio is licensed by Arcsoft, USA.
All other product names mentioned here in are trademarks or registered trademarks of their 
respective owners.

Electromagnetic Compatibility Notice

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy, and if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation.
If the unit does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:
 Re-orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver

is connected.
• Consult the dealer or any experienced TV/radio technician for help.

Caution

In order to maintain compliance with FCC regulations, shielded cables must be used with 
this equipment. Operation with non-approved equipment or unshielded cables is likely to 
result in interference to radio and TV reception.
To comply with the limits for a class B digital device, pursuant to part 15 of the FCC rules, this
device must only be installed on computer equipment certified to comply with the Class B limits.
In addition, only the supplied power cables should be used with the product. Operation with non-
certified computers, use of a cable other than that supplied, or modification of the device may result
in interference to radio or television reception and could void the user’s authority to operate this
device.

Attention

Thank you for selecting Digital Camera. Please read the instructions carefully for a thorough
understanding before taking pictures.
• This camera is not resistant to water and should not be used outdoors in snow or rain. If 

accidentally dropped in water, please quickly pour out the water. Let it to dry by sunlight or 
by air-blower.

• Protect it from excessive humidity. It will wet the lens and picture will be blured.
• Do not attempt to disassemble the camera yourself. Always take it to an authorized service 

facility for repair.
• Remove the batteries if you do not expect to use the camera for 1 month or longer.
• To store the camera, wrap it in a clean, soft cloth and place in a cool, dry, dust-free place. 

Also it should not be placed in a very hot temperature condition or in direct sun light.
• The battery may explode or cause burns if disassembled, recharged, shorted, exposed to high

temperature, or disposed of in fire.
• Take care on the lens. Use special cloth to clean it.
• Condensation is a problem when bringing cold equipment into a warm room. Try to put the 

camera in plastic bag so condensation forms on the outside of the bag.
• If nothing at all is displayed in the LCD panel, the battery may be inserted in opposite polarity.
• Turning off the power will cause the loss of all stored photos. Make sure you have uploaded 

the photos to the PC before turning the power switch to Off.
• You will hear a ‘Gi’ sound and the camera will not function to take a photo if the environment 

is too dark or too bright. It will operate properly for normal light intensity.
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In This Package
• Digital Camera
• Digital Camera Software CD-ROM
• USB cable

Note: 3 x AAA batteries needed for the Digital Camera are NOT included.

System Requirements
• Multimedia PC Pentium 133 or higher / Mac G3 or higher
• Windows 98 / 98SE/Me/2000/NT for USB port / Mac OS 8.6 or higher
• 32MB RAM (Me is recommended to use 128MB)*
• 500MB hard disk space recommended
• CD-ROM drive
• Color monitor with 16 bit or above
• USB port for connection
• Color Inkjet or Laser Printer to output photos (optional)

*  Photo Studio for Mac requires 64MB SDRAM

Getting Started

• Nomenclature

Digital Camera User Guide

Shutter button LCD panel

Viewfinder

Battery Door
Mode button

USB port
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Prepare to Upload the Photos

Digital Camera User Guide

Batteries Installation

1. Open the battery door at the back of your camera.
2. Install 3 x AAA Alkaline batteries into Digital Camera, as shown.
3. Make sure to orient the positive (+) and negative (-) ends of the batteries exactly as 

shown.
4. Replace the door.

CAUTION – To avoid battery leakage:
• Non-rechargeable batteries are not to be recharged.
• Be sure to insert the battery with the correct polarities according to battery manufacturer’s 

instructions.
• Remove the battery from product before extended storage.
• Always remove an old or dead battery from the product.
• Do not short-circuit the supply terminals.
• Check that the contact surfaces are clean and bright before installing the battery.

Installing Digital Camera CD-ROM Software

• Insert the CD-ROM disc into your drive.
• The installation will start automatically.
• Follow the installation instructions.
• You can choose any of the three Arcsoft software – PhotoFantasy, PhotoStudio & Photo

Printer.
• After installation is complete, click ‘Finish’ button to install the Digital Camera driver.
• The system must be restarted to complete the installation.

Running Digital Camera Suite

• Click ‘Start’ from the Windows Taskbar, then search through ‘Programs’/Digital Camera
Suite.

• Choose any of the three Arcsoft software to run it.

Uninstalling Digital Camera Suite

• Click ‘Start’ from the Windows Taskbar, then search through ‘Programs’/Digital Camera
Suite.

• Click the Uninstall icon and follow the on-screen prompts.

Or you can uninstall the software with the following steps:
• Click ‘Start’ from the Windows Taskbar, then click on ‘Setting’.
• Click on ‘Control Panel’.
• Double click on ’Add/Remove Programs’.
• Scroll down and highlight ‘Digital Camera Suite’.
• Click on ’Add/Remove Programs’ and the ’OK’.
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Connecting Your Digital Camera to the PC / Mac

USB

If your computer has a USB port, insert the
USB plug of the camera cable into the USB

 port on your computer.

If you success to connect the camera with
 the computer, you’ll hear a beep, beep sound.

AVI Creator Program

• It is a program to create a video file from the camera.
• AVICreator will install in your hard disk automatically after Arcsoft’s software install 

completed.
• To launch AVICreator, click ‘Start’ from the Windows Taskbar, then search through 

‘Programs’/Digital Camera Suite/ AVICreator’.

USB cable

PC

USB port
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Taking Photos
Once your Digital CD-ROM software is installed, you’re ready to learn about taking photos.

Holding the Camera
Hold the camera as shown below when taking photos.

• The camera will turn on once batteries are installed.

• A beep sound will play and the LCD panel will turn on indicating the camera is on.

• The LCD will show the capture mode           first then skip to the frame counter            .

The information shown below appears on the LCD panel

    : Activate  High Resolution Mode (VGA) from Low Resolution Mode
      "FINE" Icon will display

    : Frame counter - Max. number of available shots in FINE mode

    : Continuous Mode - taking photos continuously in FINE mode

  
    : Self-timer - 10 seconds in FINE mode

    : Clear all the photos included all the high resolution and the low resolution photos.

    : Activate Low Resolution Mode (QVGA) from High Resolution Mode, "BASIC" Icon
 will display.

    : Frame counter - Max. number of available shots in BASIC mode.

            : Continuous mode - taking photos continuously in BASIC mode.

                    : Self-timer - 10 seconds in BASIC mode.

                    : Clear all the photos included all the high resolution and the low resolution photos.

Digital Camera User Guide
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Changing the Capture Mode

• Select the Low Resolution Mode

• Press Mode button to select

• Press Shutter button to change it then the frame counter will change to 107.

• Select the Continuous Mode

• Press Mode button until   is shown.
• Hold down the Shutter button for taking photos continuously until the frame counter 

countdown to 00.

Note: The time for the AVI video is 15 seconds for Low Resolution Mode and 3 seconds for 
High Resolution Mode, in a Frame/Rate at 7 fps.

• Select the Self-timer Mode
• To take photos with the self-timer, press Mode button until            for High Resolution

or  for Low Resolution.
• Press the Shutter button to start count down.
• Beep sound is heard until the photo is taken after 10 seconds.

• Clear all the photos

• Press Mode button until            or            shown.
• Press Shutter button then the rubbish bin icon will start to flash.
• Press Shutter button again and you’ll hear a double beep sound, note that all the High 

and Low resolution photos will be cleared at once.

Remark: It will return to frame counter if the mode is not selected within 5 seconds.

Auto Off

It will Auto Off after 30 seconds without pressing any button. Press the
‘Mode’ button to power on it.

Low Battery

If at anytime the battery icon becomes "         " , it indicates low battery. Upload your photos to the
computer as fast as possible. You are recommended to change new batteries immediately.

Note: Default setting of the camera is on High Resolution Mode.

• Look through the viewfinder. The focus is set to work best when taking a photo of 
a subject that is minimum 2 feet away from the camera.

• Press the Shutter button, you’ll hear a beep sound and the frame counter will count down 
1 frame which indicates an image has been taken.

TIP: It is recommended that you take a few test shots at different distances so that you can 
understand how the photos are actually captured by the camera.
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Getting Started with Digital Camera Suite

PhotoFantasy
This is a funny role play program. In just a few seconds, you can become a supermodel, a pro
athlete, a caveman or even Santa Claus. Let’s go into the program now.

• To Launch PhotoFantasy

1. Click ‘Start’ from the Windows Taskbar, then search through ‘Programs’/
Digital Camera Suite.

2. Choose PhotoFantasy to run it.

Digital Camera User Guide

• Quick Guide for Select Input Source from Digital Camera

1. Click ‘Get Fantasy’ button in the top left corner of the Main Screen.
2. Get Fantasy Screen appears. You can select the fantasy background from Digital Camera

or software CD-ROM.
3. Get photo from Digital Camera, click ‘Scan’ button.
4. The Input Source dialog box appears, highlight ‘Digital Camera’ then click ‘Select’ button.
5. Choose your photo and click ‘Capture’ button.
6. After you prepare the fantasy background in the Main Screen, click ‘Get Photo’ button.
7. Get Photo Screen appears. Click ‘Acquire’ button to upload photo from Digital Camera.
8. The Input Source dialog box appears, highlight ‘Digital Camera’ then click ‘Select’ button.
9. Choose your photo and click ‘Capture’ button.

(For further information, please read the following description.)
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1 Get Fantasy Button : opens the Get Fantasy Screen, so you can select the fantasy background
for your photo fantasy. From this screen, you can also create your own fantasies.

2 Get Photo Button 1,2 or 3 : each of these buttons corresponds to a particular mask/ photo 
in a fantasy background.

3 Save As Button : opens the standard Windows Save As dislog box so you can save your 
finished photo fantasy under a specific path, file name and file format.

4 Print Button : opens the standard Windows Print Setup dialog box so you can select your 
printer settings and begin printing your finished photo fantasy.

5 Send Button : automatically lauches your e-mail program so you can e-mail your finished 
photo fantasy.

6 Start Over Button : revert the main display area.

7 Flip : flips your photo horizontally so it faces the opposite direction.

8 Move : moves the photo up, down, left and right.

9 Resize : makes the photo larger or smaller.

10 Rotate : turns your photo in a clockwise or counter-clockwise direction.

11 Add Text : opens a text box so you can add text to your photo fantasy.

12 Match Color : automatically adjusts the skin tone in your photo to better match the skin tone
in your selected fantasy background. To revert to the original color, click again.

13 Brightness : slide the bar to the right or left to adjust the brightness in your photo.
Contrast : slide the bar to the right or left to adjust the contrast in your photo.
Saturation : slide the bar to the right or left to adjust the saturation in your photo.

14 Zoom In : close-up look at the photo in your photo.
Zoom Out : returns the photo fantasy to the original view.

Digital Camera User Guide

• Main Screen
The Main Screen contains controls that allow you to access the other program screens, as 
well as to make final adjustments and enhancements to your photo fantasy.
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1 Fantasy Category Menu : provides a list of available fantasy categories. This list includes 
categories contained on your CD-ROM and a ‘My Fantasy’ category for adding your own 
fantasy backgrounds.

TIP: Remember to insert your Software CD in your CD-ROM drive to access the full selection
of fantasy backgrounds.

2 Fantasy Slides : small thumbnail images of your fantasy background.

3 Okay Button : places your selected photo in the Main Screen.

4 Cancel Button : without placing the selected photo in the Main Screen.

5 Add Button : lets you create a fantasy background from one of your images. Click the ‘Add’
button, the Open dialog box that appears, locate the image you want to use and click ‘Open’.

6 Scan Button : lets you create a fantasy background from Acquired image or a scanner. Click
the ‘Scan’ button, the Select Source dialog box that appears, choose ‘Digital Camera’ and
click ‘Select’. The photos thumbnails will be uploaded. Choose the photo and click ‘Capture’

 button. The photo will automatically appear in the Create Display area. Use the Masking Tools
to create your masks.

7 Edit Button : opens the Create Fantasy Background Screen.

8 Delete Button : deletes the selected fantasy slide(s) from the ‘My Fantasy’ category.

Digital Camera User Guide

Get Fantasy Screen
Clicking the Get Fantasy Button takes you to Get Fantasy Screen. Here you can select the fantasy
background from software CD and create your own fantasy background.
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Get Photo Screen
After you create the fantasy background, clicking the ‘Get Photo Button 1,2 or 3’ in the Main Screen
takes you to the Get Photo Screen. You can choose the photos for your photo fantasy and create
new category of photos.

Digital Camera User Guide

1 Photo Category Menu : provides a list of available fantasy categories. You can make your 
own category of photos, choose the ‘New’ option from the list. The default name will be ‘Untitled-
#’. Highlight the title and rename the category. To add photos to the current category, click 
the Add or Acquire button.

2 Photo Slides : small thumbnail image of your actual photo files.

3 Okay Button : places your selected photo in the specified mask (1,2 or 3) in the Main Screen.

4 Cancel Button : without placing the selected photo in the Main Screen.

5 Add Button : lets you create a fantasy background from one of your images. Click the ‘Add’
button, the Open dialog box that appears, locate the image you want to use and click ‘Open’.

6 Acquire Button : you can acquired image into current category. Click the ‘Acquire’ button, 
the Select Source dialog box that appears, choose ‘Digital Camera’ and click ‘Select’. The

 photo thumbnails will be uploaded. Choose the photo and click ‘Capture’ button. Then click 
‘Close’. The photo will automatically appear in the Main Screen.

7 Delete Button : deletes the selected photo slide(s) from the current category.
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PhotoPrinter
This is a simple program for you to print the picture in several steps. Go into the program and upload
the pictures from the camera. Select a feature to print the photo to your favor.

• To Launch PhotoPrinter

1. Click ‘Start’ from the Windows Taskbar, then search through ‘Programs’/Digital Camera
Suite.

2. Choose PhotoPrinter to run it.

Digital Camera User Guide

• Quick Guide for Select Input Source from Digital Camera

1. Click ‘Get Photos’ button in the Main Preview Screen.
2. Photo Album Screen appears. Click ‘Acquire’ button to upload photo from  .
3. The Input Source dialog box appears, highlight ‘Digital Camera’ then click ‘Select’ button.
4. Choose your photo and click ‘Capture’ button.

(For further information, please read the following description.)

11
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1 Get Photos Button : this button takes you to the Photo Album Screen where you can select
photo(s) for printing. Here you will find buttons that make it easy to create new photo albums,
delete thumbnails and acquire photos from Digital Camera.

• Click  Acquire button.
• The Select Source dialog box that appears, choose ‘Digital Camera’ and click ‘Select’.
• The photos thumbnails will upload.
• Choose the photo and click ‘Capture’ button.
• Click ‘Close’.

2 Crop Photo Button : this button brings your selected photo to the Crop Screen. In the Crop
Screen, you can trim your photo, keeping just the portion you want to print. You can choose 
between Landscape and Portrait crop orientations. Adjust the position and scale of the crop 
selection box with your cursor.

3 Edit Photo Button : this button brings your selected photo to the Edit Screen. In the Edit 
Screen, you can enhance your photo instantly. You can choose between Enhancements 
and Effects.

4 Frame Photo Button : this button brings your selected photo to the Frame Screen. You can
place it in a variety of artistic frames, borders, edges and calender background.

5 Clear Page Button : removes all photos from the Page Preview Window.

6 Printer Setup Button : gives you standard Windows printing options - printer type, paper 
size and layout orientation.

7 Print Button : begins the print job.

8 Copies (+/-) : lets you set the number of copies.

9 Size Adjuster : adjusting the size of the white space between photos along with the photo 
size.

10 Template Menu : allows you to choose from a variety of template categories.

Digital Camera User Guide

• PhotoPrinter Main Screen
The PhotoPrinter Main Screen contains buttons that let you quickly access the Photo Album,
Crop, Edit and Frame Screens.
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PhotoStudio
PhotoStudio is a powerful, easy-to-use, digital image editing program for PC’s running. It enables
full-color images to be acquired, managed, enhanced, retouched, and output for publications,
presentation, and the internet.

• To Launch PhotoStudio

1. Click ‘Start’ from the Windows Taskbar, then search through ‘Programs’/Digital Camera
Suite.

2. Choose PhotoStudio to run it.

Digital Camera User Guide

• Select Input Source from Digital Camera
1. Click ‘File’ on the pull down menu.
2. Choose ‘Acquire’ and click ‘select Source...’.
3. The Input Source dialog box appears, highlight ‘Digital Camera’ then click ‘Select’ button.
4. Choose ‘Acquire’ again and select Acquire... .
5. The photos thumbnails will upload.
6. Select the photos and click ‘Capture’ button.
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• File : The File menu contains a number of commands to manage and manipulate 
image file.

• Edit : The Edit menu contains commands for editing images. Selections can be 
controlled by cutting them out, copying them to or pasting them from the clipboard,
or by filling them with other colors.

• Mask : Add a mask for your photo.

• Transform: The Transform menu contains commands for transforming images. You can Flip,
Mirror, Rotate, and Resize your photo under this command group.

• Enhance : The Enhance menu provides a full line of advanced, easy-yo-use features for 
enhancing images. Commands such as Brightness and Contract, Hue and 
Saturation, and Tone Adjustment  are the primary tools for color correction. A 
variety of smoothing, sharpening, and special filters are provided for image 
enhancement.

• Effect : The Effect menu offers an assortment of special effects that can be applied directly
to images.

• Convert : The Convert menu provides you commands to change the data type of an image.
 It also provides functions which allow you to split the various channels that make

up an image into separate Grayscale image documents, and combine different 
channels to form a single RGB True color image.

• View : The commands in the View menu are used to manage the PhotoStudio working
space and image display, and show information about the active image.

• Window : The commands in the Windows menu is used to manage the image windows in
the PhotoStudio.

[ For further information, please see PhotoStudio’s Help Menu. ]

Digital Camera User Guide

• PhotoStudio Main Screen
The PhotoStudio Main Screen contains commonly used commands and options grouped under
different titles: File, Edit, Mask, Transform, Enhance, Effects, Convert, View Window and Help.
Each menu group title has its own pull-down menu where specific commands and options are
found. Some items in the pull-down menu may also contain a submenu, which, once clicked,
will open a dialog box on the desktop.
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AVI Creator
AVI Creator can transfer your Digital Camera photos to AVI (Video) format. The total time is 15
seconds for CIF (Low Resolution) photo and 3 seconds for VGA (High Resolution) photo.

• To Launch AVI Creator

1. Click ‘Start’ from the Windows Taskbar, then search through ‘Programs’/Digital Camera
Suite/ AVICreator’.

Digital Camera User Guide

1 Frame Rate Silde Button : silde this button to change the playback frame rate of the AVI 
file. ‘7’ represents normal speed. Larger than ‘7’ means faster playback speed. Less than

 ‘7’ means slower than normal. (Default is ‘7’)

2 Compression Check Box : click this check box to reduce the size of your AVI file. It does 
not affect the quality of the video.

3 File Control Panel : Click this button to open the AVI file. The Open dialog box will 

appear, select your file and click ‘Open’ button.

  Close the opening AVI file.

  Play button - click this button to play the AVI file.

  Stop button - click this button to stop playing the AVI file.

  Rewind button

  Fast Forward button

4 Quit Button : quit the AVICreator program.

5 Create Button : create your Digital Camera photos to AVI file.

• Create your AVI Video File

• Recommend: Select           . It will display ‘107’. Select            . Aim
 to the object. Press and hold the ‘Shutter’ button until all photos
are taken.

• Make sure your Digital Camera is connected to PC.
• Launch the AVICreator program.
• Set your Frame Rate, Compression.
• Click ‘Create’ button. A dialog box will appear.
• Input a file name and click ‘Open’ button.
• It will save the photos as AVI file in the hard disk of your PC.

• Use the File Control Panel to playback your AVI video file.

• Playing your file
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Hints On Taking Quality Photos

• If you want to take a photo of your friend, try to take at least half the body size. You will not 
get her eyes clearly if you take the whole body.

• Take care of the background light intensity. It will affect the exposure of the main object. The
camera can calculate the total light intensity of the picture to fine adjust the exposure. If the 
background is too dark,  the object will be too bright. If the background is too bright, the object
will then be too dark.

• Even you take photos outdoor, you should not let the object under the shadow. The object is
not shined by the sun means for staying in the dark. The result is unclear object and bright 
background.

• Hold the camera with both hands. Use the first finger of your right hand to press the shutter. 
Do not stand on unstable position. Any movement on the camera will cause fuzzy photos.

• Do not cover the lens with your fingers. It will obstruct the object. If greasy is attached on the
lens, clean it with a dry and soft cloth.

• It will affect the color if the light source is the fluorescent lamp or light bulb. Green color will 
be increased under fluorescent  lamps. Yellow color  will be more under  light bulbs. You can
recover the original color by using the photo editing software.

• It is better to use the USB port for upload. The power is supplied by the USB port so the battery
power can be saved.

• Keep the view finder horizontal to get correct view of image. Try to kneel down if possible.

Digital Camera User Guide
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Trouble Shooting

• Turning off the power will cause the loss of all stored photos. Please make sure you have 
uploaded the important photos before the switch is turned to off without the USB power 
provided.

• If you disconnect the USB cable during operation, you need to close the Acquire dialog panel
and then re-open it again for the PC to recognize the unit.

• The  camera is set to your country’s AC mains frequency. If you use it in another country with
different frequency (either 50 or 60Hz), you should not take the photo under the lamp.Black 
strips of line will be seen in the picture due to incorrect mains frequency. It is no problem 
under the sunlight.

• The camera will turn off automatically after 30 seconds without pressing the buttons. This 
can save the battery life. You need not to take off the battery when it is not in use. Just take 
off it if the pictures are uploaded or you will not use it for a long time, say 2 days or more.

• When the LCD is blinking, it means the battery power is low. You need to change batteries. 
You can take up to all 20 photos even it is blinking. Then upload the photos to the PC and 
change the empty batteries.

• It is not recommended to use re-chargeable batteries. Because the output voltage is lower 
than the alkaline battery. It will get battery low easily.

• If the PC cannot recognize the camera when you run the Photo program, you need to dis-
connect and re-connect the USB cord to the camera.

• You will hear a ‘Gi’ sound and the Digital Camera will not function to take a photo if the 
environment is too dark. Try to use spot light or turn on the fluorescent  lamp to get more 
light.

• After power on, it will take about 2 seconds to initialize the internal set-up. Then you will see 
the number of pictures remained. So it cannot take the picture immediately after power on or
awake from sleep mode.

• You would better to adjust the gamma of your monitor through some programs to fine tune 
the color in order to get a vivid photo on the monitor. Actually, the Photo Studio has the 
gamma adjustment to the photo.

Digital Camera User Guide
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Product Specifications

• Digital Camera
1. Resolution : 640x480 pixels (VGA), 320x240 (QVGA)
2. Lens : Plastic, two elements, F 3.0, 35mm (Equiv.)
3. Memory : 8MB SDRAM
4. Number of Pictures : 26 for VGA, 107 for CIF
5. View Finder : Yes.
6. LCD : Status LCD with ICON display
7. Buzzer : Yes. Beep sound indicates working mode
8. Picture Retention : Yes. By main power batteries.
9. Battery Power : 3A battery x 3 pcs ( 4.5V)

      10. Auto-Off : Yes. When no key is pressed for 30 seconds
      11. Upload speed : USB approximate 2 seconds per VGA photo

• Digital Camera Suite Software (PC version)

1. AVICreator : AVI video playback, approximate 15 seconds for
QVGA.

2. PhotoPrinter : Print the photo in simple steps
3. PhotoFantasy : Role play program
4. PhotoStudio : Photo editing program
5. USB driver : For Win98 / 98SE/Me/2000/NT

• Digital Camera Suite Software (Mac version)

1. PhotoPrinter : Print the photo in simple steps
2. PhotoFantasy : Role play program
3. PhotoStudio : Photo editing program
4. USB driver : For Mac OS 8.6 or higher

Responsible Party in USA

Legal Company Name: Argus Industries, Inc.
Address: 1100 Howard street

Elk Grove Village, IL 60007
www.arguscamera.com
E-Mail : argus@arguscamera.com

* Specification are subject to change without prior notice *
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Appendix I

Installing PC Driver & upload photos

A. For Win 98/Me OS users

Put the CD-ROM to the CD-ROM drive.
It will automatically start the installation.
In the final step, it will install the driver.
You can select the languages for the driver’s dialog panel.
After several seconds, it will request to re-boot.
After re-boot, plug in the USB cable to the camera and it will recognize the unit.
Check the Control Panel-System-Device Manger-Image Device-Digital Camera.

B. For Win2000 or NT users

Put the CD-ROM to the CD-ROM drive.
It will automatically start the installation of Arcsoft software.
In the final step, do not select to install the driver.
Plug in the USB cable to the camera. It will request for the driver directory.
Input the directory as D:\Drivers.  There are two files for the setup (stv680.cab, stv680.inf).
Then it will install the files to the hard drive.
Check the Control Panel->System->Device Manger-Image Device-Digital Camera.

C. For Win95 users

Put the CD-ROM to the CD-ROM drive.
It will automatically start the installation.
In the final step, it will install the driver.
You can select the languages for the driver’s dialog panel.
After several seconds, it will request to re-boot.
You can only use RS232 port to connect the camera for Win95 OS.

What can you do with the TWAIN driver

• Upload the images stored in the camera
• Play video (like a PC camera) and capture a frame by clicking the Capture icon
• Change the format (Low or High resolution) and the quality of video
• Clear the memory in the camera

How to read the user manual

Goto Start-Program Files-Digital Camera Suite, double click on the User Manual icon
If you have not installed the Acrobat Reader 4.0, pls double click the file ar40eng.exe in the program CD-ROM. It
will do the installation of the Acrobat Reader 4.0.
**This user manual file (called Manual.pdf) is placed  in the CD-ROM main directory.

Digital Camera User Guide
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How to upload the images with the Arcsoft programs.

A. PhotoStudio

Goto Start-Program Files-Digital Camera Suite, double click on the PhotoStudio
Select File-Acquire-Select Source, select the Digital Camera
Select File-Acquire-Acquire, it will open the TWAIN driver dialog panel.
If you have taken some photos and connected the USB cable,

  it will upload the thumbnails in several seconds.
Double click on each thumbnail you can get the full size image.
(You can select some or all photos by holding the shift or control keys.
Then hold the shift and control keys together, double click the selected thumbnails to upload the selected photos
continuously.)

Select Video Mode

Change Gamma value

Open Photo Studio Front panel Select source

Select Digital Camera Acquire See thumbnail

See full size Can select all files

Delete photo warning Video play Capture in Video Mode

Set to 1.000

Digital Camera User Guide
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B. PhotoPrinter

Click Start-Programs-Digital Camera Suite, double click on the PhotoPrinter.
Select the Get Photos icon.
Select the Camera icon.
Select the source : Digital Camera. Click OK.
It will appear the dialog panel.
Uplaod any or all photos to a new template in the PhotoPrinter.

C. PhotoFantasy

Click Start-Programs-Digital Camera Suite, double click on the PhotoFantasy.
Select the Get Fantasy icon. It will show the photos stored in the templates.
Select one of them and click OK.
Then select  the Get Photo icon (#1).
Select the Camera icon.
It will appear the dialog panel.
Upload any or all photos to a new template in the PhotoFantasy.

**There is the help file for each Arcsoft program. Click the Help or the ? icon to read it if you have problems to use
the software.

How to play AVI Creator

It is recommended to use the Low resolution mode(QVGA size, 320 x 240) to take 107 photos.
Press the Mode button once, it will show Ct. Press and hold the shutter and pointed to the object. The film counter
is counting down and beep beep sound is heard. Until it counts to 00, you can release the shutter button. Connect
the camera to the PC with the USB cord.
Select Start-Programs-Digital Camera Suite, double click on the AVICreator.
Double click the Create icon. Enter the filename you want.
Press the ‘Enter’ key to start making the AVI video file.
Wait until the first frame is appeared. Click on the play icon to start movie playback.

• It will take very long time to make the AVI video if you use RS232 port. Please use the USB port.
• The file size of such AVI video is very large (24MB for 15s playback of CIF size video). It is recommended to use
Compression. Tick the box beside the Compression icon. This will reduce the size to 6MB.

Open AVICreator Input the filename

Create

Ready to play

Digital Camera User Guide

7

21



Appendix II

Installing Mac Driver & upload photos

This MAC version CD-ROM consists of 8 folders and one PDF document listed as below :

1) Acrobat Reader 3.0 : Acrobat Reader for reading a PDF file
2) MAC driver : CP084 MAC driver version 1.4b3
3) English : English version of Arcsoft programs
4) Italian : Italian version of Arcsoft programs
5) French : French version of Arcsoft programs
6) German : German version of Arcsoft programs
7) Spanish : Spanish version of Arcsoft programs
8) Contents : Photo samples for PhotoFantasy and PhotoPrinter.
9) Manual for MAC : A PDF document used as the quick start guide.

** Acrobat Reader is normally installed in the MAC unit. You need not to install it unless your MAC unit has not done
this.

How to install the MAC driver and programs

A. Install the MAC driver

Put in the CD-ROM to the CD-ROM drive of you MAC or iMAC unit.
Check the folders you can find the Driver folder.
Inside it there is the MAC driver called Digital Camera Installer V1.4b3.
Double click on it to start the installation.
Click Continue. It will appear ‘Preparing to install’.
Click the Choose icon.
Click the OK icon.
Click the Quit icon.
The installation is finished.

 B. Try to upload photos

Take some photos with the camera.
Connect it to your MAC unit with the USB cable.
It will appear the dialog panel.
You can select any folder or create a new folder to save the photos.
Click the Save icon to save the photos.
It will request if you want to clear the photos stored in the camera.

Upload photo
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C. Install PhotoFantasy, PhotoPrinter or PhotoStudio

In the CD-ROM, you can find the folders English, Italian, French, German and Spanish.
Select the language you need.
Eg. English folder. Inside it with the Arcsoft programs.
Click on the PhotoFantasy.
Click on the Install icon.
After installation, click on the Quit icon.
Do this the same for the other two programs.
** it needs 64MB SDRAM in order to start installation of the PhotoStudio.

Camera Control

CD ROM Folders Arcsoft Programs

Install Photo Fantasy

Install Photo Printer End

End

End

Install Photo Studio

Digital Camera User Guide

23



D. Get the photos with the Arcsoft programs

1. PhotoFantasy

Find the folder of PhotoFantasy in the hard drive.
Double click on the PhotoFantasy 2000.
It will see the dialog panel of PhotoFantasy.
Click on the Get Fantasy icon.
Select a Fantasy photo and click OK.
Click on the Get Photos (#1) icon.
Click the Add icon.
Select a photo from the folder you stored the photos of the camera.
Open the photo file and you can see the photo.
Click OK to select this photo.
You can see the photo is mixed with the Fantasy photo.
Continue to do what you want by clicking the icons.

2. PhotoPrinter

Find the folder of PhotoPrinter in the hard drive.
Double click on the PhotoPritner 2000.
It will see the dialog panel of PhotoPrinter.
Click the Get Photos icon.
Click the Add Photo icon.
Select a photo from the folder you stored the photos of the camera.
Open the photo file and you can see the photo.
Continue to do what you want by clicking the icons.

3. PhotoStudio

Find the folder of PhotoStudio in the hard drive.
Double click on the PhotoStudio 2000.
It will see the dialog panel of PhotoStudio.
Select File -> Open.
Select a photo from the folder you stored the photos of the camera.
Open the photo file and you can see the photo.
Try to select other items in the top pull up menu.

*Help files are ready for the Arcsoft programs. Click on the
Help item or ? icon to read the help file automatically.

Digital Camera User Guide

24



Appendix III

FREQUENTLY ASKED QUESTIONS :

1. I always take bad quality photos at home, why?
Take the photo with enough light intensity. You need to take photos in your office or outside with sunlight. It is
not recommended to use it indoor at night.

2. How to get a good photo of my friend?
 If you want to take a photo of your friend, try to take at least half the body size. You will not get her eyes clearly

if you take the whole body.

3. I found some of the photos with the body too dark.
Take care of the background light intensity. It will affect the exposure of the main object. the camera can calculate
the total light intensity of the picture to fine adjust the exposure. If the background is too dark, the object will be
too bright.  If the background is too bright, the object will then be too dark. Change the position of you so that
the object and the background are in the similar light intensity.

4. I tried to take photos outdoor, but some of them with the object too dark.
Even you take photos outdoor, you should not let the object under the shadow. The object is not shined by the
sun means for staying in the dark. The result is unclear object and bright background.

5. Some of the photos I have taken with unclear image (ghost image)
Hold the camera with both hands. Use the first finger of your right hand to press the shutter. Do not stand on
unstable position. Any movement on the camera will cause fuzzy photos. Do not move or run when you press
the shutter.

6. Some photos have bad image quality partially.
There is no lens cover. Do not cover the lens with your fingers. It will obstruct the object. If greasy is attached
on the lens, clean it with a dry and soft cloth.

7. Can I take a photo of the Sun?
Do not point to a strong light source such as the Sun. It may damage the CMOS image sensor inside the camera.
The background will be too dark and you see nothing in the photo.

8. The color of the image is somehow changed when I take photos indoor.
It will affect the color if the light source is the light bulbs. It would better for you to take photos with daylight bulb
or fluorescent lamp.

9. How to use the view finder to get a good image?
Keep the view finder horizontal to get correct view of image. Try to kneel down if possible.

10. Can I take a photo in a short distance?
Do not take a photo with the object distance too close. It becomes out of focus if it is shorter than 0.3m (1 feet).

11. Some of the photos with black dots or too bright, why?
When you take a photo in a brighter environment and then take another photo in a darker environment, it will not
get correct exposure. Try to wait several seconds before pressing the shutter.

12. Why is the image too bright when it is seen in the monitor?
You would better to adjust the gamma of your monitor through the PhotoStudio program. Change the Gamma
value if you found that the photo is too bright. Select View and then Monitor Gamma. Change the RGB gamma
rate from 1.4 to lower value, eg. 1.

13. As I take the photo in another country, there are horizontal black strips appeared!
The camera is set to your country’s AC mains frequency (eg. It is 60Hz for USA). If you use it in another country
with different frequency (50Hz), you should not take the photo under the lamp or indoor. But it is no problem under
the sunlight.

14. The spring contacts are bent when I open and close the battery door many times.
Close the battery door gently. It will damage the spring contacts if you close it too hard.

15. Sometimes the unit becomes mal-function as my child tabs the camera.
Do not tab the camera on hard objects like the wooden table. This may cause the battery power fail and affecting
the photo quality.
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16. Can I use it when it is raining?
Do not use it when it is raining or it is easy to get water drops. This camera is not protected from water.

17. Will the PC be damaged if I connect the camera with the USB cord?
The current consumed from the USB port is small amount compared with the maximum output of the USB port.
It will not damage the PC when something is wrong to the DC power line.

18. How to get the user manual hard copy?
The user manual is in PDF format. It can be printed out by the Arcobat Reader 4.0. This file is stored in the CD-
ROM provided. The filename is areng40.exe. Double Click on it and it will start installation. After installation,
double click on the manual.pdf file. It will open the Arcobat Reader and then open the user manual. You can print
it out by selecting File-Print.

19. What other files inside the CD-ROM are important for me?
Important files inside the CD-ROM :
In the main directory of it : D:\
- Manual.pdf  : user manual
- AVICreator.exe, stv680cp.dll : AVI Creator files
- ar40eng.exe : Arcobat Reader 4.0. For reading pdf files.

In the Drivers folder  :  D:\Drivers\
dc1102xv.exe : PC driver. Install USB/RS232 camera driver.

20. How to uninstall the PC driver?
Uninstall the camera driver from the hard drive :
Goto C:\Windows\System. Delete the files with ‘stv’ pre-fix.
Goto C:\Windows\System32\Drivers. Delete the file stv680.sys.

21. If the power is off if the camera has a switch, will the images be kept?
No. Turning off the power will cause the loss of all stored photos. Please make sure you have uploaded the
important photos before the switch is turned to off without the USB power provided.

22. Is it a disposable camera?
This is not a disposable camera. You can use it whenever the power is ready and the memory is not full.

23. Which way (RS232 or USB) to upload the images is better?
It is better to use the USB port for upload. The power is supplied by the USB port so the battery power can be
saved and the upload speed is 20 times faster.
Even you connect both ports, it will select the USB port.

24. How to save file size for the AVI video play for CIF model?
The file size of a photo (CIF size, save as BMP file) is 298KB. For 20 photos, the file size will be ~6000KB (equal
to the AVI file size). If the compression is set to on in the AVICreater, the file size will be reduced to ~1000KB
but the video quality is not so good.

25. Should I turn off the battery power if the camera has a switch when I am not using the camera?
The camera will turn off automatically after 30 seconds without pressing the buttons. This can save the battery
life. You need not to turn off the power when it is not in use. Just turn off it or change fresh batteries if the pictures
are uploaded or you will not use it for a long time(eg. 2 days or more).

26. What kind of batteries should I use for this camera?
It is recommended to use alkaline batteries. This will get longer battery life time. And the performance is better
than the normal batteries.

27. Can I use rechargeable batteries?
It is not recommended to use rechargeable batteries. Because the output voltage is lower than the alkaline battery.
It will get battery low easily.

28. The LCD is blinking after using the camera for some time, why?
When the LCD is blinking, it means the battery power is low. You need to change the batteries. You can take
up to all 20 photos (CIF model) or 26 photos (VGA model) even it is blinking. Then upload the photos to the PC
and change the empty batteries.

29. The PC does not recognize the camera, what can I do to recover this problem?
If the PC cannot recognize the camera when you run the Photo program, you have to disconnect and reconnect
the USB cord to the camera.
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30. Sometimes I cannot take a photo, why?
You will hear a ‘Gi’ sound and the camera will not function to take a photo if the environment is too dark or too
bright. It will operate properly for normal light intensity.

31. I found the unit is not function but ‘20’ (CIF model) or ‘26’ (VGA model) is seen on the LCD. Why?
When old batteries are used, it may happen lock up. You cannot take a photo and the counter is always ‘20’ (CIF
model) or ‘26’ (VGA model). Change to new batteries if it cannot recover this problem by open and cover the
battery door.

32. Can I take a photo immediately the unit is powered on?
After power on, it will take about 2 seconds to initialize the internal set-up. Then you will see the number of pictures
remained. So it cannot take the picture immediately after power on or awake from sleep mode.

33. I cannot use the camera for my PC with Win95 and RS232 port.
Both the RS232 ports are occupied by some devices like Modem card.
You need to disable one of them or add a RS232 card to get two free RS232 ports.

34. I cannot install the driver to the Gateway PC. How to make it work?
The Gateway PC has a different installation process of  the Windows OS. They put the important files in the
hidden drive. So it cannot work for some Gateway PCs in USA.

35. The unit is off but the power switch is turned to on. I cannot take a photo, why?
Press the Mode button to wake up the unit when it is auto off to standby mode.

36. When I select other mode by pressing the Mode button, it seems has no action.
Press the Shutter button to confirm the function you have selected after pressing the Mode button. Please note
it will back to normal mode if  you did not press the shutter button for 5 seconds.

36. I have placed the batteries but the unit is not turned on, why?
Please take care below items :
If the batteries are inserted correctly, the front LED indicator is on.
If there is the power slide switch, you need to turn it to on.
Make sure you have inserted the batteries according to the direction shown.
The LCD displays ‘20’ (CIF model) or ‘26’ (VGA model)when just power on.
Do not drop the camera to hard surface. Do not put it into water. The camera will be malfunction if you do it.

37. Can I use this camera as a PC camera (web cam)?
Yes, you can. Eg. Microsoft NetMeeting, Arcsoft Video Impression. But you must use the USB port (Win95 users
are not valid).

38. How many images I can take for this camera?
For the CIF models, it has 20 CIF images or 80 QCIF images.
For the VGA models, it has 26 VGA images or 107 QVGA images.
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